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Overview

The Development Services Department’s (DSD) online permitting system is a full cloud-based application that
allows customers to apply for permits online and upload plans and documents for review 24/7.

Before you begin, please review the information about the permit submittal requirements at
sandiego.gov/dsd.

When new permit applications are received, DSD will review the documents for completeness, assess
required permit fees and assign thet project to a reviewer. Reviewers will send out their cycle issues report
as they complete each cycle, but resubmittal can only happen after all reviews have been complete.
Applicants must address all cycle issues prior to resubmitting any new plans. You cannot resubmit to each
specific discipline - resubmittals are for all disciplines at the same time.

o For help with user accounts or uploading documents, please call us at 619-446-5000.
o For plan requirements and document issues, please click here.
» For help planning you project, consider booking a virtual counter appointment with DSD.

e How to submit an application

e Apply for a Construction Permit:
e General Permit
e CIP and Public Projects

e Master Plan Accessory Structure
e Master Plan MDU and Master Plan SDU
e Master Plan Small Cell Telecom

e Required Documents

| received an “Updates Required” email. How do | upload the requested documents?

| received a “Review Pending Invoice Payment” email. How do | pay?

| received a “Recheck Required” email from a review discipline; how do | look for the
Issues Report?

o |received a “Ready for Resubmittal” email; how do | submit the requested documents?

e | received a “Final Version Signed Off” email. What do | do next?

e | received a "Review Complete/Permit Ready for Payment” email; how do | pay my
invoice?

e | received an “Issuance Checklist Requested” email; how do | submit the requested
documents?

e Permit status is “Issued;” how do | download my approved plans?

e How do | schedule inspections?



http://sandiego.gov/dsd
https://www.sandiego.gov/sites/default/files/dsd-document-requirements.pdf
https://www.sandiego.gov/development-services/virtual-appointments
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e How to submit a construction change application

e | received a "“Pending Invoice Payment” for my construction change; how do | pay?

e How do | download approved plans for my construction change?

e How do | apply for a Deferred Fire Submittal?

e How do | apply for a Deferred Submittal?

e How do | print an Approval Report and an Invoice Report?

Appendix A - Workflow/record status mapping and definitions

Appendix B - Requirements to Upload Plans and Documents

2
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HOW TO SUBMIT AN APPLICATION

e Loginto your online
permitting account.

LN Development Permits  Code Enforcement  Short Term Rental

Please Login :
[ ]
Enter your username and Many online services offered by the Agency require login for security reasons. If you are ing user. please enter Login
password'* your user name and password in the box on the right. Ui Mene or -k
New Users
1 If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts, checking on the

*|f you are a new user, see the el i e
tutorial on how to register for Register Now »
[ Remember me on this computer
an account. s i P Ao

e Select “Development Permits”
BTG C B Development Permits ode Enforcement Short Term Rental

AF Apply for a Permit Q search for a Permit Application

e Select “Apply for a Permit”
Home QLETEILTT AN NIl Code Enforcement  Short Term Rental

I iz Apply for a Permit I Q search for a Permit Application

e Read and acknowledge the General Disclaimer -

disclaimer This website is intended for convenience and informational purposes only.
e Click “Continue Application”

While we strive to ensure the accuracy. timeliness, and function of this website, the
City of San Diego makes no representations or warranties regarding its content,
condition, sustained performance, resistance and immunity to computer viruses or

malware, or proprietary infringement.

‘ | ’a\re read and accepted the above terms.

Continue Application »
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https://aca-prod.accela.com/SANDIEGO/Dashboard.aspx?TabName=Home
https://aca-prod.accela.com/SANDIEGO/Dashboard.aspx?TabName=Home
https://www.sandiego.gov/sites/default/files/final_opendsd_2.0_tutorial_01.12.18.pdf
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Select a Record Type

Apply for a Building Construction Permit
Rev. 3/14/2023

e Select a permit type from “Building Applications,” then click “Continue Application”

Note: For PTS Permits, please refer to instructions in the OpenDSD User Guide to PTS Projects.

Select a Record Type

» Building Applications
() Building Construction
(O Building Construction - CIP or Public Project
(O Building Construction - Master Plan Accessory Structure
(O Building Construction - Master Plan MDU
(O Building Construction - Master Plan SDU
(O Building Construction - Master Plan Small Cell Telecom
(O Building Construction - Special Programs
(O Deferred Fire Submittal
(O Deferred Submittal
5 (O) Demolition
() Fire
(O Plan - Mechanical/Electrical/Plumbing Standalone
() Sign

P Construction Change
(O Building Construction Change
(O Fire Construction Change

» Miscellaneous Applications
(O Construction Noise Permit
(O Individual Historical Resource Nomination
(O Mills Act Agreement
(O Others
() Street -Tree Permit
(O) Zone History Letter

» Photovoltaic

Continue Application

Jump to a permit type for the next step:

e General Permit

e (IP and Public Project Permit

e Master Plan Accessory Structure Permit

e Master Plan MDU and Master Plan SDU Permit
e Master Plan Small Cell Telecom

@

() Photovoltaic
(O Photo-voltaic Residenfial Project
» Simple No Plan Permits
() No-Plan - NonresidentialMultifamily - Electrical
(O No-Plan - NonresidentialMultifamily - Mechanical
() No-Plan - NonresidentialMultifamily - Plumbing
() No-Plan - Residential - Combination Mech/Elec/Plum

» PTS
(O) PTS Electronic Submittal

> Grading, Right of Way, Mapping Applications
() Deferred As Graded
() Engineering - Mapping
(C) Engineering Construction Change
() Grading, ROW, Mapping - Associated Submittal
(O Rignt of Way - Dry Utilities
(O Right of Way - Minor - Rapid Review

» Discretionary Applications
(O Discretionary Project

» Traffic & Transportation
(O Traffic Control Permit
(O) Transportation Permit

» Project Contacts
() Add/Remove Licensed Contractor

RETURN TO TOP


https://www.sandiego.gov/sites/default/files/opendsd-user-guide-pts-projects.pdf
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Building Construction - General Permit

1. Select “Building Construction” > Bulding Aoplicat
. . . uilding Applications
2. Indicate if there is an address for @ Building Construction
the Project Site (7 Building Construction - CIP or Public Project
3. Click “Continue Application” -

() Building Construction - Master Plan Accessory Structure

5a
ADDRESS VALIDATION
* Do you have an address for the project site?: (_) Yes () No
Add ress or Parcel Entry Tip: For numeric Street Names in single digits, add a zero (0). For example, for 1st Av use (
*Street No.: Direction: *Street N - Street Type:
e Enter Street No. and Street o e S e
name only (the system will
populate the parcel info)
e Click “Search”
OR * Parcel Number:
L Legal Description:
e Enter parcel number in ###- oLl

###-#### format (the system
will populate the address info
if it exists)

e Click “Search”
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e Enter any additional parcels
or addresses, if it applies to
your project, and include the
Unit # or Suite #

e Click “Continue Application”

Code Validation

Answer the Code enforcement Case
question:

e If“no,” continue application:

If “yes,” answer the additional
questions:

5¢ °

Project Scope and Timeline
Provide the following:

Scope

Processing timeline
Applicant type

Associated building permit
approval numbers (this is
necessary for Deferred
Submittals)

5d

Ell o

¢ When complete, click “Continue
Application”

Adsitional Information

List any edditional parcslfs) sssoclated with the project scape:

Code Enforcement

*|s there a code enforcement violation case on this

site?:

Code Enforcement

*Is there a code enforcement violation case on this site?:

Code Enforcement case number(s): *

Is this application related to the code violation?: *

Will this application resolve the code violation?: *

* Applicant Type:

Apply for a Building Construction Permit

O Yes @ No
(@ Yes () No
NC 123456
(@) Yes () No
(@) Yes () No

stionary Approval Number(s}
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Permit Specific Requirements

e Answer the No-Plan Permit
question PERMIT SPECIFIC REQUIREMENTS

*Is this application for a No-Plan Permit per Information Bulletin (0 Yes (8 No
203:

If not a No-Plan Permit, select:
Is this application for Final Only or Completion of Work: * O Yes (® No

e “Building Permit” for commercial
use of >3 unit residential use

Se --Select--
Building Permit
OR Combinatien Building Permit

e “Combination Building Permit” for
single family dwelling or duplex

* Select the applicable Permit Type: _Select—- -

e Click “Continue Application”

If you respond “Yes” to a No-Plan permit, you will be directed to the required documents page (see below)

o The maximum file size allowed is 200 MB.
[ )
Go to step 6 for full document « Requred Documents
u ploa d |nstr—u Ctl o nS l.ogz;qulred Attachment - No-Plan Building Permit Supplemental Applications (DS- Choose File | No file chosen
6

Related Permits

e Select the permits you want associated with the Building Permit application, or select “No
additional permits.”
e Click “Continue Application”

sf PERMITS

No additional permits:

Mechanical Permit:

Electrical Permit: Plumbing Permit:

4]
(<] <]

Fire Permit - Alarm: Fire Permit - Suppression:

Fire Permit - Kitchen Hood:

Fire Permit - Underground:
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Application Specific Requirements

Apply for a Building Construction Permit

Indicate the submittal type requested and answer additional related questions:

Active Project Management

APPLICATION REQUIREMENTS
*Are you requesting Active Project Management: (1)@ Yes O No
Are you submitting a Permit Now Project per IB-195: = @ Yes ) No

Did you receive approval previously from a DSD staff for Active @ Yes () No
Project Management for this application: =

Provide the DSD Staff Name: * DSD Staff Member|

General submittal
(Select Building or Combination permit)

APPLICATION REQUIREMENT S

*Are you requesting Active Project Management:

@ O Yes @ No

General -

* Select Submittal Type:

Submittal Specific Requirements

¢ Answer questions to determine
required documents
e Click “Continue Application”

5h

Rapid Review submittal

APPLICATION REQUIREMENTS

Are you requesting Active Project Management: (C) Yes (@ No
e
A Yy structures for single-dwell ng units (carports, patio () Yes () Mo

covers, fences, and retalnlng walls) uslng City of 5an Diego

standard des\gns in Bulletins: Retainil

walls (one wall type, maxlmum 6 feet in height), Awnings (up to two

types), Dx ir repairs, platforms, Roof-

equipment: *

Accessory Dwelling Unit, Junior Accessory Dwelling Unit, or Tiny O Yes O No
Home: *

Pool or Spa per approved Master Plan, up to 6 feet in depth: * O Yes ) No

Wireless Communication Facility (WCF) submittals

APPLICATION REQUIREMENTS

Are you requesting Active Project Management: () Yes (@ No

TEEER ST R Wireless Communication™

Are you submitting a Wireless Communication Facilities project () ves @ No
per IB-536:

Do you request processing under the Spectrum Act per FCC ® Yes ) No
Report and Order 14-153:

SUBMITTAL REQUIREMENTS

*|s there a Digcretionary Permit currently in the process () Yes () No
associated with this project:

*Will the pmjec‘t include new plumbing ﬁxture{s} or, in the case of () Yes () No
1 cor tion, is the project r g plumbing

fixtures:

* Does the project include Structural Calculations: () Yes ) No

* Does the project include separate Truss Calculations that are not () Yes () No
included in the plans:

* Does the project include a Geotechnical Investigation Report: () Yes () No
*|s the project proposing resldentlal deve\cpmen‘t of 10 ormore () Yes () No

g units or a t of two
oF more dwelhng unite, except as provided i m Secllon 1421303

*|s the project only for residential use: () Yes () No
* Does the project include any storage racks over 6 feet in height: () Yes () No

* 13 the project for a childcare center: () Yes () No
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Historic Designation

e Specify whether the project has a historic
designation and answer the additional
related questions

e Click “Continue Application”

Affordable Housing Requirements

e Indicate how the project complies with
affordable housing requirements
e Click “Continue Application”

Apply for a Building Construction Permit
Rev. 3/14/2023

HISTOMS DEMONATION

Enmern thea jmoge | b i b dwsipisidnad Bt 0] fmaimamow, 6 i 0 (Vi o Mo
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Dispn yosar piogoaad commuction achide werk on 8 Ui [T e i P

ety b leyh of tsurtians 43 pamen bl okded L whiih

it milll D 8 C e 10 T and e o i being bebdag or

frbterieStontty

How is the project complying with Inclusionary Affordable Housing requirements?

AFFORDABLE HOUSING COMPLIANCE

Payment of the Inclusionary Affordable Housing In- )
Lisu Foe:

The project will include affordable units: 1

The project will combing a pro-rated payment of the 1
In-Lieu Fee and affordable unit

Other method of compliance: 1

Does the project propose any of the following residential use types?

RESIDENTIAL USE TYPES

Permanent Supportive Housing: a
Transitional Housing: 1
Accessory Dwelling Units: s}
Junior Accassory Dwelling Units: a)
None of the above: 0

Does the project propose using any of the following incentive programs?

INCENTIVE PROGRAMS

$B 35 Streamiined Affordable Housing: |
Complats Communities Housing Solutions: O
100% Affordable Housing Density Bonus:
Affordable Housing Density Bonus:

Micro Unit Density Bonus:

Senior Housing Density Bonus:

Student Housing Density Bonus: 1
Affordable Accessory Dweiling Unit Bonus: )
Voluntary Accessibllity Program: u)
Other: o
Nane of the above: 1

Go to step 6 to upload documents and complete application

RETURN TO TOP
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CIP or Public Project Permit

Select a Record Type
» Building Applications

e Select “CIP or Public Project” © Buiding Construction

. " . . L (@ Building Construction - CIP or Public Project
e Click “Continue Appllcatlon (C) Building Construction - Master Plan Accessory Structure

Building Construction - Master Plan MDU

Building Construction - Master Plan SDU

Building Construction - Master Plan Small Cell Telecom
Building Construction - Special Programs

Deferred Fire Submitta

Deferred Submitia

Demolition

Fire

Plan - Mechanical/Electrical/Plumbing Standalone

() Sign

Use this application when submitting for Capital
Improvement Program Projects or projects at City-
5@  owned facilities.

Note: For PTS Permits, please refer to instruction in
the OpenDSD User Guide to PTS Projects.

CIP Classification

Answer the CIP classification question. P LSRG
sp If the answer to the classification * ire you submitting a Public Project on behalf of a City @ Yes () Mo
Department

question is “No,” you will need to submit
to a different permit type.

Address Validation
ADDRESS VALIDATION

e Indicate if there is an address for
the Project Site
e Click “Continue Application”

*Do you have an address for the project site?: () Yes () No

5c


https://www.sandiego.gov/sites/default/files/opendsd-user-guide-pts-projects.pdf

5d

S5e
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Address or Parcel Entry

Enter Street No. and Street
name only

Click “Search” (the system will
populate the parcel info)

OR

Enter parcel number in ###-###-
#i### format

Click “Search” (the system will
populate the address info if it
exists)

Enter any additional parcels or
addresses, if it applies to your
project and include the Unit # or
Suite #

Click “Continue Application”

Project Scope and Timeline

Provide the following:

AownN =

Scope

Processing timeline

Applicant type

Associated building permit approval
numbers (this is necessary for
Deferred Submittals)

When complete, click “Continue
Application”

Apply for a Building Construction Permit

Tip: For numeric Street Names in single digits, add a zero (0). For example, for 1st Av use

*Street No.: Direction:  *Street Name: Street Type:

v

1222 —Selectw 01st A

* Parcel Number:

Legal Description:

Additional Infarmation
asing

nit numbers) associated with the project scape:

Projectinformation
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Permit Specific Requirements

e Answer the No-Plan Permit
question

If not a No-Plan Permit, select:

e Building Permit for commercial
use of >3 unit residential use

OR

5f

e Combination Building Permit for
single family dwelling or duplex

e Click “Continue Application”

Apply for a Building Construction Permit

PERMIT SPECIFIC REQUIREMENTS

*1s this application for a No-Plan Permit per Information Bulletin O Yes @ No
203:

* Select the applicable Permit Type: .-Selecte-

--Select—

Building Permit
Combination Building Permit

I

If you respond “Yes” to a No-Plan permit, you will be directed to the required documents page (see below)

o e Go to step 6 for full document
upload instructions

Related Permits

The maximum file size allowed is 200 MB.

* Required Documents

1. Required Attachment - No-Plan Building Permit Supplemental Applications (DS- Choose File | No file chosen
6005)

e Select the permits you want associated with the Building Permit application, or select “No additional

permits.”
e C(Click “Continue Application”

Sg PERMITS
No additional permits: O
Electrical Permit:
Fire Permit - Alarm: O
Fire Permit - Underground: O

Historic Designation

e Specify whether the project has a
historic designation and answer
the additional related questions

e C(Click “Continue Application”

5h

Mechanical Permit:

(<<

Plumbing Permit:

Fire Permit - Suppression:

00

Fire Permit - Kitchen Hood:

HISTOES DE BGNATION

D thes sl cosmlaia @ duwainpstnd bianorsy wacesci, 80 B 8 () Yo ) M2
Exlgined duiigsiied ki ST,

Uk e gy corirmsied o ol e aivchies on i pojecinie: ©

PO TAMT. T a0y 1IraCTares On W 08 4 597y 0f Dder PO iied sove #7n] [he DInponed @0nk B simena. e (e
Coe yousr pHOpCREEl 1o hude work an o alte T e i N

P Y % e il o kbt I bl

vty et B £ B 1 Dl SiBgue! OF O b ka0
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Submittal Specific Requirements
SUBMITTAL REQUIREMENTS

° Answer q uest| ons to d ete rm | ne *Is there a Digcretionary Permit currently in the process () Yes () No
associated with this project:
req u | red d ocuments *Will the project include new plumbing fixture(s) or, in the case of () Yes ) No
commercial construction, is the project removing plumbing
H " 1 i i " fixtures:
e Click “Continue Application
* Does the project include Structural Calculations: () Yes () No
5h * Does the project include separate Truss Calculations that are not () Yes () No
included in the plans:
* Does the project include a Geotechnical Investigation Report: () Yes () No
*Is the project proposing residential development of 10 ormore (O Yes () No
dwelling units or a i conversion of two
or more dwelling units, except as provided in Section 142.1303:
* s the project only for residential use: () Yes () No
* Does the project include any storage racks over & feet in height: () Yes (O No
* Iz the project for a childcare center: () Yes () No

o Go to step 6 to upload documents and complete application
Master Plan Accessory Structure Permit

Select a Record Type > Euilding Applications

(O Building Construction
e Select “Master Plan Accessory Structure” () Building Construction - CIP or Public Project
(@ Building Construction - Master Plan Accessory Structure
(7 Building Construction - Master Plan MDU
Building Construction - Master Plan SDU

Use this application to establish a design for an

accessory structure to be used for future Building Construction - Master Plan Small Cell Telecom
construction projects; for example, a swimming Building Construction - Special Frograms

5a Deferred Fire Submittal
p00|. Deferred Submittal

However, do not use this record to submit to
construct a swimming pool; for that, use Building
Construction and select either a Building Permit or
Combination permit.

Project Scope and Timeline

Project Information

Provide the following:

“What is the processing fimeline requested for this 2 =7
application?:

1. Scope
2. Processing timeline
3. Applicant type

* Applicant Type:

5b

e When complete, click
“Continue Application”
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Submittal Requirements

¢ Indicate if the design includes
structural calculations
e C(Click “Continue Application”

Apply for a Building Construction Permit

SUBMITTAL REQUIREMENTS

* Does the project include Structural Calculations: () Yes () No

o Go to step 6 to upload documents and complete application

5a

5b

5¢

Master Plan MDU and SDU Permit

Select a Record Type

e Select “Master Plan MDU"
or “Master Plan SDU”

Use this record to establish a design
and to submit phases for a Master
Plan Multi Dwelling Unit or a Master
Plan Single Dwelling

Occupancy Classification

Answer the questions regarding
occupancy and process

e Click “Continue Application”

Address Validation

Answer the address validation question.
You must have an address or assessor’s

parcel number to continue the application.

e Click “Continue Application”

» Building Applications

() Building Construction

) Building Construction - CIP or Public Project

() Building Construction - Master Plan Accessory Structure
(@ Building Construction - Master Plan MDU

(O Building Construction - Master Plan SDU

) Building Construction - Master Plan Small Cell Telecom
) Building Construction - Special Programs

) Deferred Fire Submitial

) Deferred Submitial

) Demolition

) Fire

) Plan - Mechanical/Electrical/Plumbing Standalone

() Sign

OCCUPANCY CLASSIFICATION

* Salact Occupancy ClassMication for ihiz appllcation:

Unit RoF

" Salgct the process requested for thiz application as defined In I .
tha 1B 114: o Step

ADDRESS VALIDATION
*Do you have an address for the project site?: ) Yes ) Mo

Do you have an Assessor's Parcel Number{s)?: = () Yes () Mo
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Address or Parcel Entry Tip: For numeric Street Names in single digits, add a zero (0). For example, for 1st Av use (
o Enter Street No. and Street name *Street No. Direction:  *Street Name: Street Type:
Only 1222 --Select 01st av -

e Click “Search” (the system will
populate the parcel info)

OR * Parcel Number:

e Enter parcel number in ###-###- Legal Description:

#i### format
e Click “Search” (the system will
populate the address info, if it
5d exists)

e Enter any additional parcels or
addresses, if it applies to your
project and include the Unit #
or Suite #

e Click “Continue Application”

o e For Master Plan MDUs, go to step 6 to upload documents and complete application
e For Master Plan SDUs, continue with the following steps

Project Scope and Timeline

Project Information

Provide the following:

" Deflne the scops of the work:

*What s the processing timeline requested for this —
application?: 2 e
Provide assoclated prir Discretionary Approva hwtar(ln

Scope

Processing timeline
Applicant type

. Associated discretionary
permit, if any

 Appilcant Typa:

S5e

AwnNn -

e When complete, click
“Continue Application”



Development Apply for a Building Construction Permit

SD.) Services

Submittal Requirements

¢ Indicate whether an associated

discretionary permit is currently

in process am?maal:jﬂl}!;anr;!mnary Permit currantly In the process assoctated () Yes @ Mo
e Click “Continue Application”

SUBMITTAL REQUIREMENT 5
5f

o Go to step 6 to upload documents and complete application

Master Plan Small Cell Telecom

Select a Record Type
» Building Applications
QO Building Construction

0O A .
 Select Buﬂdmg Construction - Master Plan QO Building Construction - CIP or Public Project

ACCQSSOFy Structure” QO Building Construction - Master Plan Accessory Structure

QO Building Construction - Master Plan MDU

Use this application to establish a Master Structural O Building Construction - Master Plan SDU
. @ Building Construction - Master Plan Small Cell Telecom
Plan for an 5G-Small Cell and Equment to be QO Building Construction - Special Programs
. . O Deferred Fire Submittal
5z Mounted on various types of streetlights and O Deferred Submital
signalized pole standards within the City 8 E_emo‘"‘on
ire

Public Right-Of—Way. O Plan - Mechanical/Electrical/Plumbing Standalone

QO sign
However, do not use this record to submit to
construct/mount equipment on streetlights and/or
signalized poles; for that, use Right of Way - Dry
Utilities record type.
Project Scope and Timeline
Provide the following: Submmioaliformason

o e I -
1. Scope l
Sb 2. Processing timeline ] - l
3. Applicant type E

e When complete, click Contous fapteaion
“Continue Application”

6 Go to step 6 to upload documents and complete application
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Required Documents

Upload Required Project Documents

. . . The maximum file size allowed is 400 MB.
Required documents will be listed

* Required Documents

° SeIect "ChOOSE FiIe" and drag/drop 1. Required Attachment - Fire Alarm Plans Nﬂthosem
or search your files to attach them. 2. Required Attachmen - Fire Permit Workshest No file chosen

e You will not be able to continue if
files have not been uploaded.

If you encounter Failed Scout Validation,
use the Scout link and check your files.

Scout Validation Help

Additional Documents

Upload any Additional Documents The maximum file size allowed is 200 MB.
you wish to include with your I
submittal
Fee Worksheet 190KB.pdf 189.58 kB Fire Permit Worksheet

e Click “Add”

Fire Plans 1.2MB.pdf 1.2MB Fire Protection Plans


https://scout-epr.eplansoftreview.com/#!/scout
https://www.sandiego.gov/sites/default/files/dsd-document-requirements.pdf

SD)

Development
Services

Select “Choose File” and

Apply for a Building Construction Permit
Rev. 3/14/2023

New Attachment X

drag/drop or search your files

to attach them

New Attachment

Click Type drop-down and select | Choose File | Project Contact Information Form.pdf

file type

Type

Provide a brief description of

the document

Click the “Submit” button
Click “Continue Application”

Workers' Compensation
Declaration (if applicable)

Select the insurance
declaration statement
that applies to this
project (Not applicable
for Master Plan
Accessory Structure)
Click “Continue
Application”

Project Contacts Information -

Description

Contact form

Waorker's Compensation Declaration: | hereby affirm under penalty of perjury one of the following declarations:

WARNING: FAILURE TO SECURE WORKERS' COMPENSATION COVERAGE IS UNLAWFUL, AND SHALL SUBJECT AN EMPLOYER TO CRIMINAL PENALTIES AND CIVIL FINES UP TO ONE
HUNDRED THOUSAND DOLLARS ($100.000), IN ADDITION TO THE COST OF COMPENSATION. DAMAGES AS PROVIDED FOR IN SECTION 3706 OF THE LABOR CODE. INTEREST. AND
ATTORNEY'S FEES.

I hereby affirm under penalty of perjury one of the following declarations:

*indicates a required field.

DECLARATION

| am either self-insured or will maintain workers compensation insurance:

| am not subject to workers compensation insurance: ()
(=

To be determined at the time of permit issuance; O
r

RETURN TO TOP
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Review Application

Building Construction

S Declaration 6 Review 7 Submitied

Project
23 information

Review the Application and
return to previous steps by
clicking on the numbered tabs
at the top.

e revew il Inform:

elow. Chek the "EGR” buttons to make changes to 56<tions of ‘Continue AppICation” 1o move

Record Type

|
g

Bullding Construction

Address Validation

ADURESS VAUDATION
Do you have an address for the project site?

i

Address

]
g
s
r

Parcel Number: §35-433-2800
Logal Description: BLK 1 ST CLSDGBLKS 13 THRU 156

Additional Information-if applicable

Adaiional Information
List any ndditional parcel{s) associated with the project scope: List any unit number(s) associated with the project scope:

Code Case Validation
»

£
g
|
!

Is there 3 code enforcement violation case on this ~ No

Select Scope and Timeline

H
g
§ 5
g
:
=§
%
4
H
]

Wihat is the processing fimeline requested for this application?: Standard
Applicant Type: Authorized Agent of Property Owner of Other Person per MC  Provide associated prior Discretionary Approval Number(s):

§
:

Does the project propose any of the following residential use types?

RESIDENTIAL USE TTPES
Permanent Supportive Housing: No
Transitional Housing: No
Accessory Dwelling Units: No
Junior Accessory Dwelling Units No
Nore of the above. Yes

Does the project propose using any of the following incentive programs?

INCENTIVE PROGRAMS.

5B 35 Streamlined Affordable Housing No
Complete Communities Housing Solutions No
100% Affordable Housing Density Bonus No
Affordable Housing Density Bonus: No
Micro Unit Density Bonus: No
Senior Housing Density Bonus No
Student Housing Density Bonus: No
Atfordable Accessory Dwelling Unit Bonus: No
Voluntary Accessibility Program: No
Other: No
None of the abave: Yes
Declaration
DECLARATION
I am either self-insured or will maintain workers No

compensation insurance
1am ot subject to workers compensation insurance:  No
Ta be determined at the time of permit issuance: Yes

1 cartty that | have rmad tris sppicaion and stale the above mlermation s correct an that | am e properly cwner, rlecest or

of the property owner, o ather perscn having » eg.

ntisemont to e usa of e praperty Mat is the subject of this appication (Muniioal Coda Section 112 8102). 1 undarstand that the apoicant  (ESDONSIBAe 1of KWING 30K COMBY N WEN he Govarming

DORCIES B0 FEQUIBNIONS BDDICA0N 10 FVE PODOSEA GRVEOOMENT 0F DRI TG Gy & hOT BADIR 104 Ay ARMADES O 1953 FESUTING O I ACHUA OF 85600 TAAE 10 AR e BPOREANT Of 31y B0ENCADIE

s or reguiabons, mciuding before or gunng fnal mspectens. ity peroval of 3 pemmt

G209, INCliGng al rea1ed Dians and GoCEmen, | 1013 QAN o 39Proval 10 violale any apRACabIE pOMCY or

Teguialian, noc dows # conSENute @ waer by e iy 1o DUIES any TerMecy, WACh May be avaZable to anforch and Comect VCIASOS Of e JpDACabIa POCES aNd reQUIBSONS. | SUthorZe repras entatives

othe Gy 1o enter (e abeve-idenhed propeely or inspection purposes. | have The authortly and grant Clly ST and dvisory bodies The right 1o tmake Copgs: of any piams or report

wronct Iy v

b od r ravigw

04 parma pracessing

Guration o

By checking this box, | agree 1o the above certification. Date:
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e Acknowledge the final

certification
e Click “Continue Application" | certify that | have read this appcation and state the above inform:

entitlemeant to the use of the propery that is the subject of this appli
policies and regulations applicable to the proposed developmnent or
laws or regulations, including before or during final inspections. City

" regulation, nor does it constitute a waiver by the City to pursus any

the city to enter the above-identified property for inspection purpose

checking this box, | agree to the abowe certification.
Continue Application »

Your record number will created and
displayed, and an email with further

Step 8:Submitted

. . . Your application has been successfully submitted.
instructions wi I I be sent. Please print your record and retain a copy for your records.

Thank you for using our online services.

12 Your Record Number is PRJ-8001732.

You will need this number to check the status of your application or to schedule/check results of insg
fees have been assessed or permit issuance has been processed.

Choose “View Record Details” to Schedule Inspections, check status, or make other updates.

View Record Detalls »

You will receive a system generated email Hello,
with your project number and what to ) -
Development Services has created your application.

expect next. Record ID: PRJ-8005336|
Record Address:
Record Type: General
Pilease do not reply to this email, this mailbox is not monitored.

Thank you for your application. Your documents have been received and will be processed in the order
13 submitted.

For current application processing timeline, click here

The progress of your application can be tracked through your Online Permitting Account
For questions about your user account or help uploading, contact 619-446-5000

Thank you,

City of San Diego
Development Services Department
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| RECEIVED AN “UPDATES REQUIRED” EMAIL. HOW DO | UPLOAD THE REQUESTED DOCUMENTS?

e Log into your Online Permitting [EESRY ocvetommentpermis - Co Enorcemens  shors Term e
Account
Please Login Login
Many online services offered by the Agency require lagin for security reasons. If you are an existing user. please enter
d Enter your username and your user name and password in the box on the right. User Name or E-malil:
password. New Users
1 If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:

have the added benefits of seeing a complete history of applications, access o invoices and receipts. checking on the
status of pending activities, and more.

[ Remember me on this compter
I've forgotien my password
New Users: Register for an Account

Register Now »

Open the “Updates Required” email. Hello,

e Click either of the email links to go Pilease do not reply (v this email, this mailbox is not monitored.

i Your application has been Pre-Screened and requires updates. Please see attached report for
to your account and make project P P v
updates

Follow the steps below to upload the requested documents:

Login to your Online Permitting Account
Search and select the application number
Click on the Attachments tab

Add the required documents

Requested information must be submitted within 30 days of this email or this application will
be Withdrawn.

An email notification will be sent with the next steps to complete the submittal process.
The progress of your application can be tracked through your Online Permitting Account
For questions about your user account or help uploading, contact 619-446-5000

Thank You,
City of San Diego

Development Services Department

Your project information will load Record PRJ-8003236:

e Click the “Attachments” tab BLI Ild I ng COhStI’UCtiOI"\

Record Status: Updates Required

Record Info Payments

21
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Previously attached

To upload attachments:

documents will be displayed. i Gl Ads to st e proces
2. Click Add for each file to upload
The maximum file sze allowed Is 200 MB.
H " 1"
¢ Click “Add Attachment et
Attachments (2)
File Name: File Size Status Type

Storm Water Req. Applicability Checklist (DS-560) PRI-8003236.pdf 1218 Uploaded Storm Wa
Building Construction Plans PRJ-8003236.pdf 414MB  Uploaded Building C

e Select “Choose File” and
drag/drop or search your New Attachment *
files to attach them

e Click Type drop-down and
select file type

e Provide a brief description No file chosen
of the document

: u o Type
o Click the “Submit” button

--Select-- w

Mew Attachment

Description

Enter a brief
description of the

document
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The documents will be validated by
Scout and be uploaded to the
project record (PR)) ot tatms

1. Click Add to start the process
2. Click Add for each fle to upload
“The maximum fie size allowed is 400 M.

Tips: -

Finishing upload of Fire Specs 372KB.pdf. Please wait for the page to refresh

e If you have any items to
6 submit that were not

Attachments (3)

File Name. File Size. Status. Type Refresh
requested, upload them py— e
¢ When your resubmittal o o s 0005772 T —

contains all the required
documents, the “Add” button
will disappear.

| RECEIVED A “REVIEW PENDING INVOICE PAYMENT"” EMAIL. HOW DO | PAY?

e Log into your Online [ oevtopment permisCoce Etorcement  Shrt erm e
Permitting Account i
Please Logl_n _ _ ) N Login
e Enter your username and i e e B s
password. New Users
1 If you are a new user you may register for a free Citizen A it. It only takes a few simple ps and you'll Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts, checking on the
status of pending activities. and more.

[ Remember me on this computer
T've forgotien my password
New Users: Regisier for an Account

Register Now »

¢ Open the “Review Pending Hello.

Invoice Payment” email
. . . Pre-Screen for PRJ-8005336 has been completed and an invoice with initial plan check fees is
e C(lick a link to log in to your attached.

Piease do not reply to this email, this mailbox is not monitored.

accou I"lt an d ma ke d Follow the steps below to pay the outstanding fees:
payment « Login to your Online Permitting Account
+ Search and select the application number
+ Click on the Payments tab

Pay the outstanding fees

After we receive payment, your project will be Deemed Complete and the Project Review will
begin.

NOTE: For CIP projects paying through Inter Office Transfer using SAP system, email your
DSD Project Manager to coordinate the payment.

The progress of your application can be tracked through your Online Permitting Account
For questions about your user account or help uploading, contact 619-446-5000

[Thank You,

City of San Dicgo

Development Services Department
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Click on the “Development Permits” l
tab.
. . Home Code Enforcement Short Term Rental
e Select the record listed in the

email T Apply for a Permit Q search for a Permit Application

In the dropdown list of filters above, choosing "Exclude Packages™ will filter only Project and Pen

To sort the table below, click the column name to perform an alphabetical sort on that column.
again to sort in descending order (Z-A)

Show on Map
o R Showing 1-10 of 100+ | Download results | Add to collection

] Date Record Number Record Type

)  oansr2021 PRJ-1004641 o

] ozns/z021 PMT-3004537 O corsction -

Scroll down to the search field for Records
Record Type: Record Status:
e Input the PRJ into the General ~Select-- v | -Sdea- v
SearCh in thls format: Record Number: (73 Project Name:

PRJ-1234567

Add the Project
number (PRJ-XXXXXX)

Verify that the record has the status:
“Application Pending Payment” Record PRJ-8003236:

e C(lick on “Payments”

Celoct “Fooer Building Construction
e Select “Fees

Record Status: Application Pending Payment

Record Info Payments Attachments
Fees
H " n
e Click on “Pay Fees

Outstanding:

Date Invoice Number Amount

01/12/2018 617932 $20.00 Pay Fees
01/12/2018 617932 $242.00

01/12/2018 617932 $179.00

Total outstanding fees: $441.00

24

RETURN TO TOP



| ¥ Development Apply for a Building Construction Permit
SD) Services Rev. 3/14/2023

The following screen will load. Follow :
Home Code Enforcement  Short Term Rental
instructions to pay.

+ Apply for a Permit Q search for a Permit Application

Listed below are the fees based upon the information you've entered. The following screen will display your total fees.

6 Fees

Fees Qty. Amount
Records-No Plan Permits/Other 1 $2000
PVS-Template SDU/DUP/TH (1) 1 $5242.00
PVS-Template SDU/DUP/TH (P} 1 5179.00

TOTAL FEES: $441.00
Note: This does not include additional inspection fees which may be assessed later.

| RECEIVED A “RECHECK REQUIRED” EMAIL FROM A REVIEW DISCIPLINE. HOW DO | LOOK FOR
THE ISSUES REPORT?

e Log into your online
permitting account

m Development Permits Code Enforcement  Short Term Rental

® E nte r yo ur username an d ::::::’wrt‘:eﬂ%suﬂemd:yll: Abp:ncy ltm::ugin for security reasons. f you are an existing user. please enter Login
asswo rd* your user name and password in the box on the right. User Name or E-mail:
p New Users
1 If you are a naw user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:
have the f s=eing a compl istory access lo invoices and receipts, checking on the
*|f you are a new user, see the Sl [
tutorial on how to register : _
[ Remember me on this computer
for an account SRR e O

e Select the “Development

Permits” tab Hom* Development Permits l:ode Enforcement Short Term Rental

e Apply for a Permit Q search for a Permit Application

Your records will be displayed

[ owssmoat  eRo-sooiers Fire Standara-Fre-101/4sn =y
3 S I h PR . h [0 owesizozt PMT-8001628 Approval - Censtruction - Fire Pmt f’nzr]‘;‘(;"ﬂ":““""“'”'e""" Issued
e Select the PR] you wish to see g —— e .
i ow2s/2021 cc-8001682 Building Construction Change Construction Chiange - PRJ- In Review
the Project Issues Report for m] 5008673
[ owasreo2r Cc-8001693 ing g o e In Review
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e C(lick the “Attachments” tab Tt
Previously attached documents will be ek
displayed. pou—
4 File Name File Size Status Type Refresh
You will see your Project Issues Report [— ot Frasm e
by d|sc|p||ne d|sp|ayed. Fite Permit Worksheet PRI-8001577.pdf 18958 k8 Uploaded Fite Permit Worksheet
e Click the “Actions” drop-down

Click “Download” and the
selected Project Issues Report
5  will download

Detail
, I Download I

| RECEIVED A “READY FOR RESUBMITTAL” EMAIL. HOW DO | SUBMIT THE REQUESTED
DOCUMENTS?

You will receive an email for Recheck Required if there are corrections to be made to the plans or if
additional information is needed.

e Loginto your Online

P erm itti ng ACCO u nt m Development Permits Code Enforcement  Short Term Rental
e Enter your username and — _

Many online services offered by the Agency require login for security reasons. If you are an existing user. please enter Login

passwo rd youruser rame and passsword i the bo on tha right e
New Users
1f you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:

1 have the added benefits of seeing 2 camplete history of applications, access to invoices and receipts, checking on the
status of pending activities, and more.
Register Now »
() Remember me on this computer

I've forgotten my password
New Users: Register for an Account
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e Open the “Ready for
Resubmittal” email

e Click a link to log in to your
account and update the project
documents or information

e Select the “Development
Permits” tab

Your records will display with the
current statuses.

e C(lick on the blue PRJ link of
the project

Your project information will
load.

e Click the "Attachments”
tab

Previously attached documents will
be displayed.

e Click “Add Attachment”

Hello,

Apply for a Building Construction Permit

Please do not reply to this email, this mailbox is not monitored.

All review disciplines have completed their reviews for PRI-8005336. At this time, additional
documents and information are required to continue the review process.

Follow the steps below to upload the requested documents:

Click on the Attachments tab
Add the required documents

Login to your Online Permitting Account
Search and select the application number

IMPORTANT: Al required documents requested by all review disciplines must be uploaded
,ﬁr the same time. Incomplete submittals will result in review delays.

The progress of your application can be tracked through your Online Permitting Account

For questions about your user account or help uploading, contact 619-446-5000

Thank you,
City of San Diego

Development Services Department

Homd WETELLILERIRT TSN iCode Enforcement  Short Term Rental

a7 Apply for a Permit

Q Search for a Permit Application

SNOWINg 61-70 of 100+ | Downioad rés.

Date

ownz/z021

01212021

01122021

ownzrz021

ow12/2021

ow122021

de Packages* will filter only Project and Peemit type records.

Fire

™ an ABRabetical SO o that oMM, For exampie, click "ADPICatoN Name™ 1o SOrt FeCords by Applicat

51 Name i ascending oroer (A-2). and o

Record Number Record Type Appiication Name Description Status
= Approva - Constructon - fire Pt Approwsl - Construction - Fire Pmt e
PMT-8001495 e e Opened
PRI-8001528 Fre Standord-Fire:4250/05th ssued
PT-0001486 Approvsi - Construction - Fire Pt Approval - Construction - Fire Pt Bond
2 - 122210151
ve Approval - Construction - Fire Pt Approwsl - Construction - Fire Pt e
PMT-8001437 g P Opened
T-80004 Approval - Construction - Fire Pmt Approval - Comstruction - Fire Pt -
PMT-8001498 2 il Opened
PRI-8001525 Fire Standard-Fire:1222/01st Recheck Required
Record Info Payments Attachments
To upload attachments:
1. Click Add to start the process
2. Click Add for each file to upload
The maximun file size alloved i 400 MB.
types to uplozd.
are disallowed file types to upload.
Attachments (2)
‘ Actions ~ ‘ Fire Alarm Flans PRI-8001577.pdf 1.2 MB Uploaded Fire Alarm Plans
[‘actons | Fire Permit Worksheet PRI-8001577.pdf 180.58 k2 Upleaded Fire Permit Works|
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Development
Services

Select “Choose File” and
drag/drop or search your files
to attach them

Click Type drop-down and
select file type

Provide a brief description of
the document

Click the “Submit” button

***|f submitting Applicant Response
to Issues, upload requested
documents. If the responses are for
more than one discipline, combine
responses into one PDF file for
upload***

Tips:

If you have any items to
submit that were not
requested, upload them first.
When your resubmittal
contains all the required
documents, the “Add” button
will disappear.

The documents will be validated by
Scout and be uploaded to the
project record (PRJ)

Apply for a Building Construction Permit

New Attachment X

Mew Attachment

Choose File | No file chosen

Type

--Select-- v

Description

Enter a brief
description of the

document

To upload attachments:

1. Click Add to st

ss
2. Click Add for eachfile to upload
The matmum fle sze allwed & 400 MB.

types to upload.

toupload.

Finishing upload of Fire Specs 372KB.pdf. Please wait for the page to refresh

Attachments (3)

=

Actions ~

J

Fire Alarm Plans PRI-8001577.pdf 1218 Uploaded Fire Alarm Plans

Fire Permit Worksheet PRI-8001577.pdf 189.58 k8 Uploaded Fire Permit Worksheet

Fire Alarm Specs PRI-8001577.pdf I47k8 Uploaded Fire Alarm Specs
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| RECEIVED A “FINAL VERSION SIGNED OFF" EMAIL. WHAT DO | DO NEXT?

The application is now in queue for Home DSD Code Enforcement
issuance. Refer to the Permit

Application Processing Timeline for
current issuance timelines. Building Construction

Record Status: Reviews Complete

+ Create an Application Q search Applications

Record PRJ-1048641: Add to collection

Record Info Payments

IMPORTANT: All the must be uploaded at the same time. Incomplete submittals will result in review delays.

Follow the below steps to upload the requested documents:

Click on "Add Attachment”

Click on "Choose File" and add the document

Select the correct document type from the dropdown and click on "Submit". For example, if the requested document is "Sign Plans” - select "Sign
Plans” from the "Type" dropdown.

Once you click "Submit”, wait for the page to reload confirming the document upload. Please do not try to refresh the page during this process.
Repeat the above steps to upload all the requested documents. Once all the requested documents are uploaded, the "Add Attachment” will
disappear automatically.

If the "Add Attachment” button doesn't disappear, that confirms that you have not i all the
We offer appointments for issuance
. R Permit Issuance (For Projects Signed Off by All Reviewers.) hd
of certain application types.
e To schedule an Permit Issuance: Building Permit - With Plans

1 appointment, click here. If the permit was issued prior to the Virtual
Appointment, please remember to cancel the

appointment. If your appointment is no longer
required, staff will automatically cancel it.

© 45 minutes

| RECEIVED A “REVIEW COMPLETE/PERMIT READY FOR PAYMENT” EMAIL. HOW DO | PAY MY
INVOICE?

] LOg IntO your On“ne m Development Permits  Code Enforcement  Short Term Rental
Permitting Account

Please Login

Many online services offered by the Agency require login for security reasons. If you are an existing user. please enter Login
e Enter your username and yout user name and password in the box on the right. e Naine o B ik
1 password New Users
1f you are a new user you may register for a free Citizen Access account. It only takes a few simpla steps and youTl Password:

have the added benefits of seeing a complete history of applications, access lo invoices and receipts, checking on the
status of pending activities, and more.

1) Remember me on this computer
've forgotten my password
New Users: Register for an Account

Register Now »
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SD)

Open the “Approved” email

¢ Click on the email link that
says “Online Permitting
Account” to login to your
account and upload
documents

Click the “Development Permits”
tab.

e Select the record listed in the
email

OR

Scroll down to the search field for
Records

¢ Input the PR] into the General
Search in this format:
PRJ-1234567

Apply for a Building Construction Permit

Hello)|

Piease do not reply to this email, this mailbox is not monitored.

Information Only:

‘Great News! The final version of the plans has been signed off by all review disciplines.

The application is now in queu for issuance with the exception of engineering permits, please
refer to items in red below

Refer to the Permit Application Processing Timeline for current issuance timelines. We offer
appointments for issuance of certain application types. To schedule an appointment, click here.

For Engineering permits:

= D-Sheet drawings have been forwarded to the Deputy City Engineer queue for audit and
signature. Discrepancies found in the audit may resulf in additional review cycles. Once
the drawings are signed, they will be sent to issuance staff to start the pre-issuance
process. All City Engineer audits, and engineering permit pre-issuance reviews are
processed in the order received.

B, C or U-Sheet drawings have been forwarded to the Deputy City Land Surveyor for
audit and signature. The associated project document(s) will then be sent to the County of
San Diego for recordation.

Applications will be pre-screened by issuance staff. If additional scope changes, issuance
documents; or plan check fees are required, you will be notified.

1fno additional information is required, a final invoice will be sent to you via email. Once
the invoice is paid your application/permit will be issued.

The progress of your application can be tracked through y( ir Online Permitting Account
For questions about your user account or help uploading, contact 619-446-5000
Thank you,

City of San Diego
Development Services Department

Home QRETEGTGENIRE G TiEl Code Enforcement  Short Term Rental

T Apply for a Permit

Q Search for a Permit Application

In the dropdown list of filters above, choosing "Exclude Packages™ will filter only Project and Pen

To sort the table below, click the column name to perform an alphabetical sort on that column. f

again to sort in descending order (Z-A)

Showing 1-10 of 100+ | Download results | Add to collection

(] Dpate

Record Number Record Type

M Photo-voltaic Residential

U 02/16/2021 PRJ-1004641 Project
— Approval - Construction -
uJ 02/16/2021 PMT-3004537 Electrical Pmt - BY Combo
Record Type: Record Status:
--Select-- - --Select--

Record Number: Project Name:

Add the Project

number (PRJ-XXXXXX)
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Verify that the record has the status:

. Record PMT- I
“Approved Upon Final Payment”

Approval - Construction - Electrical Pmt - PV Combo

4 e Click "Payments”
e Then, select “Fees”

Record Status: Approved Upon Final Payment

Record Info Payments

Click “Pay Fees"”

Outstanding:
Date Inveice Number Amount
5 01/12/2018 617932 520,00 Pay Fees
617932 $242.00
01/12/2018 617932 $179.00
Total outstanding fees: $441.00
The following screen will load. CodaEnorcemenShortTerm Real
e Follow instructions to pay + ApplyforaPermit 2 Search for a Permit Application
Listed below are the fees based upon the information you've entered. The following screen will display your total fees.
6 Fees
Fees Qty. Amount
Records-No Plan Permits/Other i $20.00
PVS-Template SDU/DUP/TH (I} 1 $242.00
PVS-Template SDU/DUR/TH (P) 1 $179.00

TOTAL FEES: $441.00
Note: This does not include additional inspection fees which may be assessed later.

| RECEIVED A “ISSUANCE CHECKLIST REQUESTED"” EMAIL. HOW DO | SUBMIT THE REQUESTED
DOCUMENTS?

You will receive an Updates Required email if additional information is needed to issue the permit.

® Log into your Online Permitting m Development Permits Code Enforcement  Short Term Rental

Account )
Please Login i
Many online services offered by the Agency require login for security reasons. If you are an existing user. please enter Log
e Enter your username and e o e e B
password New Users
1 If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts, checking on the
status of pending activities, and more.

[ Remember me on this computer
I've forgotien my passiword
New Users: Register for an Account

Register Now »
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e Open the “Issuance Checklist Hlo,
Requested" email Please do not reply to this email, this mailbox is not monitored.

Plan check for PRI-8005336 has been leted. There may be ding plan check fees that must be paid

(] C I i C k O n a I i n k to I Og i n to yo u r prior to uploading the requested Issuance Checklist Items shown on the attachment for permit issuance.

a Cco u nt a n d S u b m it For any outstanding fees, refer to the attached Invoice. Documents cannot be uploaded until outstanding plan

check fees are paid

d ocumen tS Follow the steps below to upload the requested documents

Login to your Online Permitting Account
Search and select the application number
Pay outstanding fees (if applicable)
Click on the Attachments tab

Uplead the requested documents

NOTE: The Inspection Contact listed on the Form DS}345 (Project Contacts Information) must have an ACA
registered account to schedule inspections. Click the following link Online Permitting Account to register.

The progress of your application can be tracked through your Online Permitting Account
For questions about your user account or help uploading, contact 619-446-5000

Thank You,

City of San Diego

Development Services Department

e Select the “Development Homy Eode Enforcament  Short Term Rental
Permits” tab

o Apply for a Permit Q Search for a Permit Application

Your records will display with the
current statuses. R ——

4umn name to perform an alphabetical sort on that column. For example. click “Application Name” (o sort records by Application Name in ascending order A-Z), and <

e C(lick on the blue PRJ link of eeled]
the project ] o Rt et et om PR e ==

- Appeowal - Construction - Fire Pmt  Approval - Construction - Fire Pmt .
ou12/2021 PMT-8001493 App e et Opened
011272021 PRI-8001528 Fire: Standard-Fire:4250/05th ssued
ke Approval - Construction - Fire Pt Approvel - Construction - Fire Pt P,
ou1272021 PMT-8001496 b s el Opened
- 7 Appecwal - Construction - Fire Pt Approal - Construction - Fire Pt i
] ouzrez PMT-8001497 g » 3 fiehrrrreet Opened
— Approval - - Fire Pt Agproval - Fire Fmt .
] ovzroa PMT-8001498 prebet N dergrouma 12231010 Opened
1 owzeoz FRI-8001525 Fite Standard-Fire:1222/01st Recheck Required

Your project information will load.

Record PRJ-8003380:
e Click the "Attachments” tab

Building Construction

Record Status: Issuance Checklist Requested

Record Info Payments Attachments
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Previously attached documents will be
displayed.

e Click “Add Attachment”

e Select “Choose File” and
drag/drop or search your files
to attach them

e Click the Type drop-down and
select a file type

e Provide a brief description of
the document

e Click the “Submit” button

Repeat until all requested documents
6 have been uploaded

The documents will be validated by
Scout and be uploaded to the
project record (PRJ)

Tip: When your resubmittal contains
7 allthe required documents, the
“Add" button will disappear.

Apply for a Building Construction Permit

To uplozd attachments:
1. Click Add to start the process
or each file to upload

disallowed file types to upload.

Attachments (2)

Fire Alarm Plans PRJ-8001577.pdf 12 Me Uploaded Fire Alarm Plans
Fire Permit Worksheet PRI-8001577.pdf 189.58 k2 Uploaded Fire Permit Works|

Mew Attachment

Choose File | No file chosen

Type

--Select-- W

Description

Enter a brief
description of the

document

upload.

Finishing upload of Fire Specs 372KB.pdf. Please wait for the page to refresh

Attachments (3)

Fire Alarm Plans PR)-8001577.pdf 12M8 Uploaded Fire Alarm Plans

Fire Permit Worksheet PR)-8001577.pdf 189.58 k8. Uploaded Fire Permit Worksheet

Fire Alarm Specs PRI-8001577.pdf 37147 k8 Uploaded Fire Alarm Specs
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PERMIT STATUS IS “ISSUED.” HOW DO | DOWNLOAD MY APPROVED PLANS?

° Log into your Online m D Permits Code Short Term Rental
Permitting Account Please Login :
Many online services offerad by the Agency require login for SECUrity reasons. If you are an existing user, please enter Login
° Enter yOUr username and your user name and password in the box on the right User Name or E-mail:
New U
1 p assword u:wwm ::er: user you may register for a free Citizen Access account. It only takes a few simple steps and you'l Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts, checking on the
status of pending activities. and more.

[} Remember me on this computer

Ive Torgotien my password
New Users: Regisier for an Account

Register Now »

* SeIeCt. the “Development Homel EREVEGLIGEEEG ISl [Code Enforcement  Short Term Rental
Permits” tab

2
r Apply for a Permit Q search for a Permit Application
Your records will be displayed
D 01/25/2021 PRJ-8001673 Fire. ‘Standard-Fire:10L/Ash Issued
3 e Select the PR] record you wish O o pursoocas e o e
. . . 017252021 PMT-8001629 P O A peecl= Cortrcticnu e e Issued
to print by clicking on the g o e e e ;
blue link Bl vt ComtuctionChnge S Gharge - =
The record details will be displayed
e Click the “Attachments” tab Record PRJ-8003204:
. Building Construction

Record Status: Issued

Record Info Payments Attachments.

The attachments for this project will
be displayed.

5  Status will be Approved

Building Construction Plans - Issued PRI-S003204.pdf 553 ME

Building Construction Plans Val, 2 - Issued PRI-8003204,pdf 165,35 ME

Aftachments (5] Approved or Reviewer Issues (2]
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The document name will contain the

word “Issued” Actions ™ Building Construction Plans - Isswed PRI-8005204. pdf

e C(lick on the .Actlons drop- Distail 1 Construction Plans Vol. 2 - Tssusd PRI-8003204,
down and click “Download” Download -

HOW DO | SCHEDULE INSPECTIONS?

e Log into your Online [ 1ome [ Permits Code Short Term Rental
Permitting Account

Please Login

Many online services offered by the Agency require login for security reasons. If you afe an existing user. please enter Login
e Enter your username and el S A
1 password New Users
If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts. checking on the
status of pending activities. and more.

Register Now »
[} Remember me on this computer
T've forgotten my password
New Users: Register for 2n Account
° CI|Ck ”My Reco rds" and your Showing 1-10 of 100+ | Download resuis | Add to collection
. . O oae Record Number Record Type Application Name Description Status.
records will be displayed
D 01/27/2021 PRJ-8001732 Fire Standard-Fire:1222/01st Issued
2 [0 owzzzoz PMT-8001697 Apbroval < construction - Fire Pmt. - Approval H":'-';";“i’z“;z‘}g';s‘ Fire Pmt Issued
O  owzzz0zt PMT-8001638 “'l’("’"c“r":r“ h‘é’;’;‘“““ﬁ““ =l “'l’("""c“r"':r“ H‘:’:‘&Z‘}g'l‘s‘ el Issued
D 01/25/2021 PRJ-8001673 Fire Standard-Fire:101/Ash Issued
[]  owzsizoz PMT-8001628 e e Issued
e C(lick on the permit number _
Showing 1-10 0f 100+ | Dewnioad resulzs | Add to collection
for which you would like to O ome Record Number Record Type Application Name Descrption status
H H D 01/27/2021 PRJ-8001732 Fire: Standard-Fire:1222/01st Issued
schedule an inspection.
01/27/2021 PMT-8001687 Approval - Construction - Fire Pmt  Approval - Construction - Fire Pmt Issued
3 - Kitchen Hood - Kitchen Hood:1222/01st
The status must be “Issued” to = Tt s e (e

Ooooo

schedule an inspection.

01/25/2021 PRJ-8001673 Fire Standard-Fire:101/Ash Issued
g Approval - Construction - Fire Pmt  Approval - Construction - Fire Pmt
01/25/2021 PMT-8001628 S e - Issued
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Click the “Record Info” tab for drop- Record PMT-8001628:
down options . )
Approval - Construction - Fire Pmt - Alarm

Record Status: Issued
Expiration Date: 01/25/2021

Record Info Payments Conditions o Attachments

e Click “Inspections” Record Info

Record Details
Processing Status
Related Records

Inspections

The inspections screen will appear,

showing upcoming and completed Please Note: Combination - Disconnect Reconnect Inspection type needs to
. . an "Electrical” upgrade(s)/replacement(s)
inspections.

Upcoming (2)
Schedule an Inspection

o Click the “Actions” link of the
inspection you would like to 1PD: Rencing Shec

'!\LJ!P(.IG! UI?.]‘“I{;F)PI"{ View Details
SC h e d u |e 01/25/2021 Scheduled Elect-Fire Alarm-Rough Tenant Imp (18517180)  Schedule

Inspector: John Bayliss

one
<Final (3) Tenant Improvement (18517181) Actions v

Completed

There are no completed inspections on this record.

e Click the “Schedule” link

Actions v

View Details
Sehedule
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e Select the date on which you
would like the inspection. It
must be a future date, not the
same day.

e Next, click the “All Day” radio
button

e Finally, click “Continue”

The following screen will be
displayed. If needed, click on
“Change contact” to enter a new
person for the inspector to contact.

If no changes are needed, click
“Continue”

The following screen will be
displayed. Review the information
and if correct then click “Finish.”

If not correct, then click “Back” and
you can edit the information or click
“Cancel” to begin the process from
the start.

Include any additional notes for the
inspector here.

Apply for a Building Construction Permit

Schedule/Request an Inspection x
calendar below:
Jan 2021 Feb 2021 Mar 2021
Su Mo Tu We Th Fr Sa Su Mo Tu We Th Fr Sa Su Mo Tu We Tt
1 2 1 2 3 4 5 6 1 2 3 4
3 4 5 6 7 8 9 7 8 9 10 11 12 13 7 8 9 10 11
10 11 12 13 14 15 16 14 15 16 17 18 19 20 14 15 16 17 1
17 18 19 20 21 22 23 21 22 23 24 25 26 27 21 22 23 24 2=
24 25 26 27 28 29 30 28 28 29 30 31
31
« Prev
O All Day
Cancel
Schedule/Request an Inspection b

Inspection type: Elect-Fire Alarm-Final (3) Tenant Improvement
Location and Contact

Verify whether the location and contact person for the selected inspection are correct.

Location
101 Ash St

Contact
DONNA D'ORSI
8586272013

Change Contact »

Back Cancel

Schedule/Request an Inspection X
Confirm Your Selection

Please confirm the details below and click the Finish button to schedule the inspection.

Elect-Fire Alarm-Final (3) Tenant Improvement
01/28/2021
101 Ash St

DONNA D'ORSI 8586272013

Include Additional Notes

Back Cancel
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e Click "Continue”

Click the link above to schedule one.

TBD Pending Elect-Fire Alarm-Final (3) Tenant Improvement (18517181) Actions w
Inspector: unassigned
You Wi | | be retu rned to th e l 01/25/2021 Scheduled Elect-Fire Alarm-Rough Tenant Imp (18517180) l Actions v

11

. Inspector: John Bayliss
Inspections screen where you can

confirm that the inspection was Completed
properly scheduled.

There are no completed inspections on this record.

HOW TO SUBMIT A CONSTRUCTION CHANGE APPLICATION

e Tologinto your Online

i D Permits Code Short Term Rental
Permitting Account, enter = ' T
Pl Logi .
yo ur usérname a nd mfya:n‘:m?e?:!:-wmwd by the Agency require login for security reasons. If you are an existing user. please enter Login
r user name and password in the box on the right. 5
password, and press the " e R UssNommorssmik
. New Users

1 LOg' n b utto n . If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and youll Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts. checking on the
status of pending activities. and more. _—

1) Remember me on this computer

I've forgoften my password
New Users: Register for an Account

Register Now »

e C(lick the “Development

Permits” tab Home QDETELLIG ARG AN Code Enforcement  Short Term Rental
e Click on “Apply for a Permit”

& Apply for a Permit Q search for a Permit Application

¢ Read the General Disclaimer
and then place a check mark General Disclaimer -
co nﬁrming your acceptance_ This website is intended for convenience and informational purposes only.

While we strive to ensure the accuracy, timeliness, and function of this website, the
City of 5an Diego makes no representations or warranties regarding its content,

3 Ap pl ication” condition, sustained performance, resistance and immunity to computer viruses or
malware, or proprietary infringement.

e Then, click “Continue

| Fave read and accepted the above terms.

38
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Select “Building Construction

Change.” » Building Applications
O Approval - Process - Agreement
Use this record for construction O Building Construction

O Building Construction - CIP or Public Project

changes to Accela projects, if your O Building Construction - Master Plan Accessory Structure

project was a PTS or Hybrid project, O Building Construction - Master Plan MDU
use the Hybrid system to apply for O Bundmg Constructton Master Plan SDU

. ding ion.=.Snoecial Programs
you construction change. @ Bulldmg Construcuon Change

O Deferred Suhmlttal
O Demolition
™ Fire
e Enter the PR] # in the exact
format PRJ-XXXXXXX CONSTRUCTION CHANGE VALIDATION
e Provide a narrative of the *Please provide the project number you would like to submit the

construction change for:

changes proposed
e Enter the permits affected by
this construction change

a pp I I Cat| on F'Iea_se qrovide all related permits associated with this CC
e Click “Continue Application” epplication:

*Please provide scope of the construction change:

s

PMT-XXXXXKPMT-XXRXXA

Continue Application »

e C(Click “Add a Row”
RELATED PERMITS
Showing 0-0 of 0
Permit Number

No records found.

—
e Enter related permit numbers
using the format PMT- RELATED PERMITS
1234567 * Permit Number:
e Click “Submit” and the PMT [pm—30045us|
will be added

L]
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Repeat if more permits are
related to this construction
change

Click “Continue Application”

Click “Add" to upload the
documents that reflect the
proposed change.

Click “Choose File” and select

from your computer.

Provide the Type of document
you are uploading

Provide a brief description of

the document

Click “Submit”

Apply for a Building Construction Permit
Rev. 3/14/2023

RELATED PERMITS

Showing 1-1of1
[ ] Permit Number

O PMT-3004505

ey

The maximum file size allowed is 200 MB.

ip are dit file types to upload.

File Name File Size Type

No attachments added

Add

New Attachment

Choose File | Building Con...n Plans.PDF
Type

‘ Building Construction Plans hd

Description

-

- [

40
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Your uploaded files will be displayed

e Click “Continue Application”

Apply for a Building Construction Permit
Rev. 3/14/2023

The maximum file size allowed is 200 MB.

4.28 MB Building Canstruction Plans

Continue Application » _

File Name

1
Building Construction Plans.PDF
i

¢ You will get the message
displaying your CC number
that was created.

e You will receive a
confirmation email with the
number as well.

12

Thank you for using our online services.
Your Record Number is CC-8001742.

You will need this number to check the status of your applicatior
fees have been assessed or permit issuance has been processed.

Choose "View Record Details” to Schedule Inspections, check stz

View Record Details» J
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| RECEIVED A “PENDING INVOICE PAYMENT” EMAIL FOR MY CONSTRUCTION CHANGE. HOW DO |
PAY?

e Loginto your Online
Permitting Account by

m Development Permits Code Enforcement  Short Term Rental

entering your username and

Please Login

passwo rd and then clickin g Many oniine services offered by the Agency reuie login for security reasons.ffyou are an exising user. lease enter OGN
your user name and password in the box on the right. et M O BerlE

on the Login button. s

1 If you are a naw user you may register for a free Citizen Access account. It only takes a few simple steps and you'll Password:
have the added benefits of seeing a complete history of applications, access to invoices and receipts, checking on the ]
status of pending activities. and more. _—
Register Now » ==
() Remember me on this computer

I've forgoften my password
New Users: Register for 2n Account

e C(lick alink to log in to your
account and make a payment

Hello,
Please do not reply to this email, this mailbox is not monitored.

Pre-Screen for PRJ-8005336 has been completed and an invoice with initial plan check fees is
attached.

Follow the steps below to pay the outstanding fees:

Login to your Online Permitting Account
Search and select the application number
Click on the Payments tab

Pay the outstanding fees

2 After we receive payment, your project will be Deemed Complete and the Project Review will
begin.

NOTE: For CIP projects paying through Inter Office Transfer using SAP system, email your
DSD Project Manager to coordinate the payment.

The progress of your application can be tracked through your Online Permitting Account

For questions about your user account or help uploading, contact 619-446-5000
[Thank You,
City of San Diego

Development Services Department

Your record will be displayed Record CC-8001682:

e Click “Payments” Tab 1.1 .
g Building Construction Change

3 Record Status: Pending Invoice Payment

Record Info Payments - Attachments

‘ Fees
42
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o C(lick “Pay Fees”

Qutstanding:
Date Invoice Number Amount
4 01/12/2018 617932 $20.00 Pay Fees
01/12/2018 617932 $242.00
01/12/2018 617932 §179.00

Total outstanding fees: $441.00

. . Fees
The following screen will load. o o
Hrly-DSD Rvw Fire Plan Proj 1 $217.93

e C(lick “Continue Application”
5 and follow instructions to

pay.

TOTAL FEES: $217.93
Note: This does not include additional inspection fees which may be assessed later.

[===]

HOW DO | DOWNLOAD APPROVED PLANS FOR MY CONSTRUCTION CHANGE?

e Loginto your Online

Perm |tt| ng ACCOU nt by m Development Permits Code Enforcement  Short Term Rental
entering your username and S - 7 e
pa SSWO rd an d th enc I | C k| ng muz:\:mzsﬂm:z‘;;gr;rler:;:r;lw::gm for security reasans. If you are an existing user. please enter R
i New U
1 on the L0g| n bUtton' If::avam as:::uwryoumay register for a free Citizen A 1. It only takes a fow simple steps and you'l Password:

have the added benefits of seeing a complete history of applications, access to invoices and receipts, checking on the
status of pending activities, and more =

() Remember me on this computer
T've forgotien my password
New Users: Register for 2n Account

Register Now »

Select the “Development Permits”
tab Homsi Development Permits rode Enforcement Short Term Rental

T Apply for a Permit Q search for a Permit Application

Your records will be displayed

01/25/2021 PRJ-8001673 Fire Standard-Fire:101/Ash lIssued
e Select the record you wish to oussaon - eur-sscicze e e

Approval - Construction - Fire Pt Approval - Construction - Fire Pmt
. . . 01/25/2021 PMT-8001629 b R tssued
3 print by clicking on the blue . i
ou25/2021 CC-8001682 Building Construction Change Construction Change - PR)- In Review

8001673

link : ) . —
01/25/2021 CC-8001693 ng ng: AOD1667 In Review

0O 00o0od
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The record details will be displayed Record CC-8001682:

* Click the "Attachments” tab Building Construction Change

Record Status: In Review

Record Info Payments I Attachments I

Work Location

e Click the “Approved or Reviewer

Issues” tab
The attachments for this CC project will
be displayed Attachments (1} &pproved or Reviewer Issues (1)
Building Construction Plans - Issued CC-8003502. paf

e Click on the “Actions” drop-
down and click “Download"” Attachments (1) Approved or Reviewer Issues (1)

44
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HOW DO | APPLY FOR A DEFERRED FIRE SUBMITTAL?

Select a record type » Building Applications
. . O Approval - Process - Agreement
e Select “Deferred Fire Submittal” O Building Construction
e Click “Continue Application" O Building Construction - CIP or Public Project

O Building Construction - Master Plan Accessory Structure
O Building Construction - Master Plan MDU
O Building Construction - Master Plan SDU
O Building Construction - Special Programs
O Building Construction Change
@® Deferred Fire Submittal
O Deferred Submittal
O Demolition
O Fire
1 O Fire Construction Change
O Photovoltaic
O Photo-voltaic Construction Change
O Photo-voltaic Residential Project
O Plan - Mechanical/Electrical/Plumbing Standalone
O Sign

» Simple No Plan Permits
O No-Plan - Nonresidential/Multifamily - Electrical
O No-Plan - Nonresidential/Multifamily - Mechanical

Continue Application

Application Info

. Submittal Validation
Provide:

*Please provide the project number you would like to submit the .
Deferred Submittal fior: PRI-B003392

e The PR| number

*Please provide scope of the Deferred Submittal: Creferred fire sprinkler
e Scope
2 e Whether itis for a single family P
home or duplex
*Are you submitting a Deferred Fire Submittal for Single Family (0 yes 8 No
Home or Duplex:
e C(lick “Add a Row,” and a
window will pop up U
Showing 1-1of 1
[l ‘Add all the Bullding Parmite far which you want azeaclate this Defamad Submittal
3 O PMT-8003950
—
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e Add the PMT number in the pop
up window using the format
PMT-1234567

e Add additional PMTs by clicking
“Add a Row"” again, until all PMTs
have been added

e Click “Continue Application”

Deferred Fire Permit Types

e Select the requested Deferred
Fire Permits
e Click “Continue Application”

Add attachments

e Click the “Add” button

Apply for a Building Construction Permit

RELATED PERMITS

* Add all the Building Permits for
which you want associate this
Deferred Submittal:

PMT-XXXXXXX

Cancel

DEFERRED FIRE PERMIT S

Fire Permit - Alarm:
Fire Permit - Kitchen Hood:

Fire Permit - Suppression:

Ooooo

Fire Permit - Underground:

The maximum file size allowed is 200 MB.

Mo attachments added
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e Select “Choose File” and
drag/drop or search for your
files to attach them New Attachment
e Click the Type drop-down and Mo file chosen
select file type
e Provide a brief description of Type
the document

. . --Select-- e
e Click the “Submit” button
e Repeat until all documents Description
have been uploaded
e Click “Continue Application”
P

o

Review

e Review the application and return to previous steps by clicking on the numbered tabs at the top
¢ Click “Continue Application”

3 ﬁfﬁoofcmtm [} g'&a“ments 5 Declaration 6 Review 7 Submitted

1 2

Step 6 : Review

Please review all information below. Click the "Edit” buttons to make changes to sections or "Continue Application” to move on

Record Type

Deferred Fire Submittal

Address Validation

ADDRESS VALIDATION
Do you have an address for the project site?: Yes

Address

1222 O1st Av
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Your record will be created and displayed,
and an email with further instructions will

be sent. Woer applicasion has beon successiully shmbod.
AR [ YORN T and BEtain 3 Copy for your records

Svep 5 Submitved

Thsnis pou for uung o online SanacEs
Vour Recond Mumbsr is FOEF- 0000017

9 Wow will naexd this numbsar 1o check the e of your applicaion o =0 schaduls’'chack resulks of iImpacsions. o pecl
oS s DOaN 2555500 OF PRIt BSEN has Boon peocssed.

Chooss View Feooed Dsails” w0 Schoduls Inspectons. checi nases. o make other updates.

HOW DO | APPLY FOR A DEFERRED SUBMITTAL?

Select a record type » Building Applications
O Approval - Process - Agreement
e Select “Deferred Submittal” to submit gguilging 8onstruction o PP
. uilding Construction - or Public Project
plans for items that were deferred O Building Construction - Master Plan Accejssory Structure
from your building permit plans O Building Construction - Masler Plan MDU
c . s e O Building Construction - Master Plan SDU
e Click “Continue Appllcatlon O Building Construction - Special Programs

O Building Construction Change
QO Deferred Fire Submittal
@® Deferred Submittal
O Demolition
O Fire
1 O Fire Construction Change
O Photovoltaic
O Pholo-voltaic Construction Change
O Photo-voltaic Residential Project
O Plan - Mechanical/Electrical/Plumbing Standalone
O Sign

» Simple No Plan Permits
O No-Plan - Nonresidential/Multifamily - Electrical
O No-Plan - Nonresidential/Multifamily - Mechanical
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Application Info
Provide:

e The PRJ number this deferred
submittal is related to
e Scope

e Click “Add a Row,” and a window will
pop up

e Add the PMT number in the pop up
window using the format PMT-
1234567

e Add additional PMTs by clicking “Add
a Row" again, until all PMTs have
been added

e Click “Continue Application”

Add attachments

e Click the “Add” button

Apply for a Building Construction Permit

Submittal Validation

Invalkd Project Status of: Pre-Scraen
* Please provide the project number you would like to submit the

Deferred Submittal for: PRI-BOO3305

* Please provide scope of the Deferred Subrnittal: Dreferred curtain wal

RELATED FERMITS

Showing 0-0of O
Permii Humbsr

No records found.

RELATED PERMITS
* Parmit Number:

| r7-2002950] |

Cancel

The maximum file size allowed is 200 MB.

No attachments added
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e Select “Choose File” and drag/drop or
search for your files to attach them New Attachment

e Click the Type drop-down and select Choose File | Building Co...ion Plans.PDF

file type (Building Construction Plans)

e Provide a brief description of the Type
document o ) o
e Click the “Submit” button Building Construction Plans

e Repeat until all documents have
been uploaded
¢ Click “Continue Application”

Description

o

Review

e Review the application and return to previous steps by clicking on the numbered step tabs
¢ Click “Continue Application”

Deferred Submittal I

. 2

3 ﬁ\r?o’fmamon 1 mm 5 Declaration 6 Review 7 Submitted

Step 6 : Review

Save and resume later

Please review all information below. Click the "Edit” buttons to make changes to sections or "Centinue Application” to move on

Record Type

Deferred Submittal

Address Validation

ADDRESS VALIDATION
Do you have an address for the project site?: Yes

Address

1222 01st Av
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Your record will be created and displayed, Step 5-Submiteed
and an email with further instructions will
Wour appliczaion has boeon succesduly aebmisod.
be sent. TPAGGE [ WO e and Bain & COpyY For yOur recmms

Thsnis pou for uung o online SanacEs
Vour Recond Mumbsr is FOEF- 0000017

Wow will naexd this numbsar 1o check the e of your applicaion o =0 schaduls’'chack resulks of iImpacsions. o pecl
oS s DOaN 2555500 OF PRIt BSEN has Boon peocssed.

Chooss View Feooed Dsails” w0 Schoduls Inspectons. checi nases. o make other updates.

HOW DO | PRINT AN APPROVAL REPORT AND INVOICE REPORT?

APPROVAL REPORT

m D Permits Code Short Term Rental

e Loginto your Online Permitting Please Login :
Many online services offered by the Agency require login for security reasons. If you are an existing user. please enter Login
Account your user name and password in the bo on the right. s
e Enter your username and i A T  ———
1 p a SSWO rd ::n:: x:-‘;“::::l S::":‘:;mlele history of applications, access to invoices and receipts, checking on the [
[ togins |
Register Now »
[ Remember me on this computer
T've fargotten my password
New Users: Register for an Account
e Click the “Development
Permits” tab and your records Homi Development Permits rode Enforcement  Short Term Rental
2 will be displayed
g Apply for a Permit Q search for a Permit Application
e Click on the PMT you wish to P S e S -
3 p r| nt th e Ap p rova I R e p 0 rt fo r 01/29/2021 PRI-8001760 Fire ‘Standard-Fire:1222/01st Issued
01/28/2021 PRJ-8001754 Fire Standard-Fire:1650/08th In Queue
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The selected record will be displayed Record PMT-8001719:

Approval - Construction - Fire Pmt - Underground

Record Status: Issued
Expiration Date: 01/29/2021

Record Info Payments Attachments

e Click on the “Reports” drop-down menu
e Select “Approval” from the menu

Anncuncements  Log

Home QEEMELRIGENTEEEN TS Code Enforcement  Short Term Rental

+ Apply for a Permit Q. search for a Permit Application

w5 Donna DOl Collactions (Offl  Repons @) % | Account Management  Logout

Record PMT-3056699: Add to collection

A pop-up window will open. Make Please input report parameter(s):
sure that the correct permit number

appears, if not, enter the correct *Approval ID:

permit number. PMT-20366593

e Click on “Submit”

INVOICE REPORT

m D P Permits Code E Short Term Rental

e Log into your Online Permitting

Please Login s
Many online services offered by the Agency require login for security reasons. I you are an existing user. please enter Login
ACCO unt your user name and password in the box on the right UESF NarhE ST rhalt
e Enter your username and Haw Users
If you are a new user you may register for a free Citizen Access account. It only takes a few simple steps and you'l Password:
have the added benefits of seeing a comgplete history of applications, access to nvoices and receipts, checlang on the
password Status of pending actties. anc more

e Click on “Development Permits”

and your records will be Home| JREECLIGENELEGN [Code Enforcement  Short Term Rental

displayed

5 Apply for a Permit Q Search for a Permit Application


https://aca-prod.accela.com/SANDIEGO/Dashboard.aspx?TabName=Home
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i i Approval - Construction - Fire
L9cate your record in the list 01/28/2021 PMT-8001710 Pmt - Underground
displayed. )
01/28/2021 PRJ-B001747 Fire
e Click on the blue link to select o )
01/28/2021 CC-8001745 Building Construction Change
that record
01/28/2021 CC-8001742 Building Construction Change

01/27/2021 I PRJ-8001732 I Fire

e To generate the Invoice report,
click on the “Payments” Tab
and then on “Fees”

Record PMT-8001719:

Approval - Construction - Fire Pm:

Record Status: Issued
Expiration Date: 01/29/2021

Record Info Payments - Attachments
) e

Make note of the invoice number

Record Info Payments Attachments
Fees

Paid:

Date Invoice Number Amount
01/29/2021 80992 $599.34

Total paid fees: $599.34

e Click on the “Reports” drop
down menu
e Select “Invoice” from the menu

Announcements Logged in as:Donna D'Orsi Collections {U)I Reports (2) "l Account Management Logout
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A pop-up window will open. Make
sure that the correct invoice number
appears. If not, enter the invoice
number.

e Click on “Submit”
¢ Invoice of Permit or Project will
be displayed in PDF format.

Apply for a Building Construction Permit
Rev. 3/14/2023

Please input report parameter(s):

* Invoice Number:

I 81183 I

E3 3
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APPENDIX A - WORKFLOW/RECORD STATUS MAPPING AND DEFINITIONS

Task Name

Pre-Screen
Pre-Screen
Pre-Screen
Pre-Screen
Pre-Screen

Pre-Screen

Pre-Screen

Project Review

Project Review
Project Review
Project Review
Project Review
Issuance
Issuance

Issuance

Issuance

Issuance

Issuance

In Queue

In Process
Updates Required
Resubmitted
Route to EPR

Documents Routed to EPR

Pending Invoice Payment

In Review

Recheck Required

Final version submitted
Review Complete
Ready for Issuance

In Progress

Updates Required

Resubmitted

Approved Upon Final
Payment

Approved Upon Final
Payment

Closed

In Queue
Pre-Screen
Updates Required
Resubmitted
Pre-Screen

Pre-Screen

Application Pending Payment

In Review

In Review

In Review

In Review

Review Phase Complete
Review Phase Complete
Issuance Checklist Requested

Issuance Checklist Submitted

Approved Upon Final Payment

Issued (When all Permits are set
to Issued)

Closed (When all Permits are set
to Closed)

55

Initial submittal from applicant

The Pre-Screen process has been started by staff and a due date is set

Staff determines during Pre-Screen that the applicant's submission is incomplete
The applicant has submitted any additional documents requested during Pre-Screen
Staff has routed the applicable documents to EPR for plan review (e.g. plans)

System confirmation that documents have been routed to EPR for plan review

Staff has deemed the submission complete, assessed fees for plan check, and the
project is ready for review

The status of the project review until all disciplines sign-off and the project is ready for
issuance

Reviewer has requested a resubmittal of documents and/or information

The final version will be reviewed by all disciplines

The project review has completed and requires one last assessment by issuance staff
The review phase can be closed out and the project is ready for issuance

Permit issuance is in progress

Issuance Checklist items are needed prior to permit issuance

Issuance Checklist items have been resubmitted by the applicant

Staff has confirmed that all required documents are present, approved plans are
available in Accela, and all required fees have been assessed at both the project level
and the permit level

Inspection invoice(s) will be sent to customer. When all fees are paid, permit is issued.

The record is closed. Any changes to the building construction plans require a
construction change application.
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Sheet Numbering
Please make sure your sheet numbers are located in the bottom right corner of your plans. Use the designated
templates or follow sheet numbering styles to ensure the timely processing of reviews.

File Size
The max size of each file you can upload cannot exceed 200MB. File sizes larger than 200MB will be rejected.

FIX: Return to the source document and create PDF files that are below the file size limitation.

Page Size
PDF files with page sizes 8.5- by 11-inches are accepted for DSD-approved fillable documents and required
reports. However, plans must be at minimum 11- by 17-inches and a maximum of 36- by 48-inches.

FIX: Return to the source document and change the paper size to meet the requirements.

Page Orientation

Having a mix of paper sizes and orientations is not a problem, as orientation issues will not prevent the file from
being accepted. However, this will generate more difficult reviewing conditions for review teams. A warning will
pop-up if different orientations are found to help you research whether any pages are upside down or improperly
oriented.

FIX: Verify that pages are not upside down or improperly oriented.

Password Protection
Files must not be password protected. If the PDF cannot be opened, the file will be rejected.

FIX: Remove the password protection to allow users to open the PDF.

Annotations and Comments
An annotation is any ‘object’ that appears in the Adobe Reader ‘Comment’ panel. It could be a ‘comment’ or
‘stamp’ or font issue like SHX Text from AutoCad.

FIX: To remove annotations in a PDF, use the print to PDF option. This process eliminates annotations by
“flattening” the PDF.


https://www.sandiego.gov/development-services/forms-publications/design-guidelines-templates
https://www.sandiego.gov/development-services/forms-publications/design-guidelines-templates
http://www.sandiego.gov/sites/default/files/dsd-document-requirements.pdf
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